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関連するアプリケーションノートと Code Examples：ここをクリックしてください。 
  

その他のサンプル コードが必要な場合は、以下のとおり対応いたします。 

ModusToolbox を使用して増え続ける CYW20819 Code Examples のリストにアクセスするには、サ

イプレス GitHub ポータルの CYW20819 Code Examples リポジトリにアクセスしてください。 

AN225684は、BT 5.0準拠の Arm®  Cortex® -M4CPUベースの超低消費電力 MCUである CYW20819 Bluetooth (BT) 

MCU を紹介し、Classic BT と Bluetooth Low Energy (BLE) の両方をサポートします。このアプリケーションノー

トは、デバイスアーキテクチャ、開発キット、およびソフトウェア開発ツールの概要を示し、CYW20819 デバイ

スの使用を開始するのに役立ちます。ModusToolbox IDE と Bluetooth ソフトウェアデザインキット (SDK) を使用

して簡単な BLE アプリケーションを作成する方法を示します。また、CYW20819 についての学習を促進するため

に、オンラインで利用できるより多くのリソースへのガイドも提供します。 
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1 はじめに 

Bluetooth 接続を特徴とするアプリケーションは、低消費電力、アプリケーションレベルの機能の増加、BoM コスト

とボードスペースの縮小に向かっています。CYW20819 Bluetooth ワイヤレス MCU を使用すると、これらすべての

重要な要件を満たすことができます。コア Bluetooth 機能の点で、このデバイスは Bluetooth 5.0 に準拠しており、デ

ュアルモード Bluetooth オペレーションをサポートしており、BLE (1 Mbps & 2 Mbps) および (EDR 2 Mbps & 3 Mbps) 

データレートをサポートしています。CYW20819は、Bluetooth Mesh 1.0仕様も完全に実装しています。CYW20819

は、強力なArm Cortex-M4 CPUと、外部のオンボードセンサーとのインターフェースを支援する ADC、SPI、UART、

I2C などの周辺ブロックのホストを持つことにより、付加価値アプリケーション機能もサポートします。これらの周

辺ブロック、オンチップフラッシュメモリ、および統合された降圧レギュレータと LDO レギュレータの存在により、

BoM コストと PCB フットプリントの削減も可能になります。サイプレスの高度な CMOS 製造プロセスとさまざま

なシステム電力モードのサポートにより、CYW20819 を使用した電池式の低電力アプリケーションを設計できます。  

http://www.cypress.com/
https://www.cypress.com/datasheet/CYW20819
http://www.cypress.com/modustoolbox
https://github.com/cypresssemiconductorco/Code-Examples-BT-20819A1-1.0-for-ModusToolbox
https://github.com/cypresssemiconductorco/Code-Examples-BT-20819A1-1.0-for-ModusToolbox
https://github.com/cypresssemiconductorco/Code-Examples-BT-20819A1-1.0-for-ModusToolbox
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このデバイスは、オーディオ (ソース) 、センサー (医療、家庭、セキュリティ) 、HID、リモートコントロール機能、

およびその他の IoT アプリケーションのホストでの使用を目的としています。 

 このアプリケーションノートは、以下をカバーすることにより、CYW20819 デバイスを使い始めるのに役立ちます。 

• CYW20819 デバイスの機能とアーキテクチャの概要。 

• ソフトウェア開発プラットフォーム、ハードウェア評価プラットフォーム、Code examples、アプリケーション

ノート、およびその他の関連技術ドキュメントを含む、CYW20819 デバイスの開発エコシステムサポートの概

要。 

• ModusToolbox™ IDE ソフトウェアで CYW20819 デバイスを使用してアプリケーションを開発する方法に関す

るチュートリアル。シンプルな BLE ベースのアプリケーションを最初から作成する段階的なプロセスを実行し

ます。 

このアプリケーションノートでは、BLE または従来の Bluetooth プロトコルの詳細については説明しません。読者は

これらのプロトコルの基本にすでに精通していることを前提としています。 

2 CYW20819 の概要 

CYW20819 は、BLE およびクラシック Bluetooth (BR、EDR) の両方をサポートする 2.4 GHz トランシーバーを内蔵

した Bluetooth (BT) 5.0 準拠のワイヤレス MCU です。図 1 に、デバイスの高レベルのアーキテクチャブロック図を

示します。 

http://www.cypress.com/
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図 1. CYW20819 ブロック図 

 

  

http://www.cypress.com/
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2.1 デバイスの機能 

▪ Bluetooth サブシステム 

o Bluetooth コア仕様バージョン 5.0 に準拠 

o BLE (1 Mbps および 2 Mbps) 、Basic Rate (BR) 、Enhanced Data Rate (EDR) 2 Mbps および 3 Mbps、

eSCO のサポートを含みます。 

o 最大+4 dBm のプログラム可能な TX 出力電力 

o 優れた受信感度 (BLE 1 Mbps で 95.5 dBm)  

▪ マイクロコントローラ 

o 最大速度 96 MHz の強力な Arm Cortex-M4 コア 

o 256 KB のオンチップフラッシュ、176 KB のオンチップ RAM  

o ROM に組み込まれた Bluetooth スタック、ペリフェラルドライバー、およびセキュリティ機能 (1 MB) 

により、アプリケーションはオンチップフラッシュを効率的に使用し、外部 MCU を必要とせずにスタ

ンドアロンで動作します。 

o AES-128 および True Random Number Generator (TRNG)  

o 楕円曲線デジタル署名アルゴリズム (ECDSA) 署名検証を含む ROM のセキュリティ機能 

o Over-the-air (OTA) ファームウェアアップデートのサポート 

• 有効なペリフェラル 

o 最大 40 の GPIO 

o I2C、I2S、UART、PCM、および 2 つの SPI / Quad-SPI インターフェース 

o 最大 28 のアナログチャネルを備えた補助 ADC 

o プログラム可能なキースキャン 20 x 8 マトリックス、3 軸直交信号デコーダー 

o 汎用タイマー、PWM、Real-time clock (RTC) 、watchdog timers (WDT)  

• 電源管理とクロッキング 

o On-chip power-on reset (POR) 、Integrated Buck (DC-DC) 、および LDO レギュレータ 

o On-chip software-controlled power management unit (PMU)  

o 電力消費を最適化する複数のシステム電力モード 

o デバイス動作用の 24 MHz 外部水晶発振器 (±20 ppm 精度)  

o オプションの外部 32 kHz 水晶発振器サポートを備えたオンチップ 32 kHz 低電力発振器 (LPO)  

• Wi-Fi との共存 

o サイプレス Wi-Fi パーツで使用する Global Coexistence Interface (GCI)  

o SECI 互換 Wi-Fi パーツで使用する Serial Enhanced Coexistence Interface (SECI)  

電気的仕様を含むデバイスの詳細については、デバイスのデータシートを参照してください。 

2.2 対象アプリケーション 

▪ ウェアラブルとフィットネスバンド 

▪ 音源アプリケーション 

▪ BLE Mesh Home および産業オートメー

ション 

▪ 血圧モニターおよびその他の医療アプリ

ケーション 

▪ 近接センサー 

▪ キーフォブ 

▪ サーモスタットと温度計 

▪ 玩具 

▪ リモコン 

http://www.cypress.com/
https://www.cypress.com/datasheet/CYW20819
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3 開発エコシステム 

3.1 ソフトウェアエコシステム-ModusToolbox 

サイプレスは、CYW20819 アプリケーションのソフトウェア開発プラットフォームとして ModusToolbox を提供し

ています。ModusToolbox ソフトウェアは、サイプレスデバイスを既存の開発方法に統合できるようにするツールの

セットです。ツールの 1 つは、アプリケーションの構成と開発をサポートする ModusToolbox IDE と呼ばれるマルチ

プラットフォームの Eclipse ベースの統合開発環境 (IDE) です。図 2 は、ModusToolbox ソフトウェアに含まれるツ

ールの概要を示しています。 

図 2. ModusToolbox ソフトウェアの概要 
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3.1.1  ModusToolbox を使い始める  

ModusToolbox のホームページにアクセスして、ModusToolbox の最新バージョンをダウンロードしてインストール

してください。ModusToolbox ソフトウェアのインストールについては、ModusToolbox ホームページの

Documentation タブにある ModusToolbox インストールガイドを参照してください。インストール後、

ModusToolbox を起動し、次の項目に移動してください。 

▪ クイックスタートガイド：Help > ModusToolbox IDE Documentation > Quick Start Guide を選択してくださ

い。このガイドでは、ModusToolbox の基本的な使用方法について説明します。 

▪ ユーザーガイド：Help > ModusToolbox IDE Documentation > User Guide の詳細なユーザーガイド。  

これらのドキュメントは、ModusToolbox ホームページの Documentation タブからも利用できます。 

3.1.2  ModusToolbox IDE  

ModusToolbox IDE は、Eclipse IDE の「Oxygen」バージョンに基づいています。Eclipse C / C ++開発ツール (CDT) 

プラグインを含む、いくつかのプラグインを使用します。サイプレスは、ModusToolbox IDE の使用方法に関するヒ

ントを提供する Eclipse サバイバルガイドを提供しています。  

IDE には、Eclipse 標準のメニューとツールバーに加えて、図 3 に示すように、プロジェクトエクスプローラー、コ

ードエディター、コンソールなどのさまざまなペインが含まれています。標準の Eclipse IDE との 1 つの違いは、

「ModusToolbox パースペクティブ」です。このパースペクティブは、「Quick Panel」、「News View」を提供し、

プロジェクトエクスプローラーにタブを追加します。IDE では、最終的にデバイスにプログラムする最上位のエンテ

ィティはアプリケーションと呼ばれます。アプリケーションは、1 つ以上の Eclipse プロジェクトで構成されていま

す。IDEはプロジェクト間のすべての依存関係を自動的に処理します。また、ソフトウェア開発キット (SDK) によっ

て提供されるさまざまなツールを起動するためのフックも提供します。  

http://www.cypress.com/
http://www.cypress.com/modustoolbox
http://www.cypress.com/modustoolbox
http://www.cypress.com/modustoolbox
https://www.cypress.com/EclipseIDESurvivalGuide
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ModusToolbox IDE を使用すると、次のことができます。 

1. キットまたはデバイスでフィルターされたスターターアプリケーションのリストに基づいて新しいアプリケーシ

ョンを作成するか、Code examples のコレクションをオンラインで閲覧してください。 

2. ワークスペースでハードウェアシステムデザインを構築するためのデバイスリソースを構成してください。 

3. ソフトウェアコンポーネントまたはミドルウェアを追加してください。 

4. アプリケーションファームウェアを開発してください。  

図 3. ModusToolbox IDE の概要 

 

3.1.3  CYW20819 の SDK 

SDK は ModusToolbox ソフトウェアの中心的なコアを提供します。SDK を使用すると、デバイスリソースの複雑な

情報をすべて理解する必要がなく、サポートされているデバイスのファームウェアを簡単に開発できます。SDK に

は、構成ツール、ドライバ、ライブラリ、ミドルウェア、およびさまざまなユーティリティ、Makefile、スクリプト

が含まれています。CYW20819 アプリケーション開発は、ModusToolbox 内の 20819A1 SDK によって可能になりま

す。20819A1 SDK の重要な機能を以下に示します。 

• デバイス ROM に含まれるデュアルモード Bluetooth (BT) スタック (BR / EDR および BLE)  

• 組込み BTアプリケーション開発用の BTスタックおよびプロファイルレベルの API (同じデバイス上のホストと

コントローラー)  

Menus & 
Toolbars 

Code Editor 

Console 

Project 
Explorer 

Quick 
Panel 

http://www.cypress.com/
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• WICED™HCI プロトコルにより、より強力なプロセッサとのインターフェースを必要とするアプリケーション

の開発を簡素化 

• SPI、UART、ADC などのオンチップ周辺ブロックにアクセスするための API とドライバ。  

• サポートされる Bluetooth プロトコルには、Generic Access Profile (GAP) 、Generic Attribute Profile (GATT) 、

Security Manager Protocol (SMP) 、Radio Frequency Communication Protocol (RFCOMM) 、Service Discovery 

Protocol (SDP) 、BLE Mesh Protocol が含まれます。  

• BLE および BR / EDR プロファイル API、ライブラリ、サンプルアプリケーション 

• Over-The-Air (OTA) アップグレードのサポート 

• SDK API リファレンス：Help > ModusToolbox API Reference > WICED API Reference を選択してください

。この HTML 形式ガイドは、CYW20819 デバイスに関連する SDK API に関する情報を提供します。図 4 に示す

ように、API 関数は論理的にコンポーネントにグループ化されており、簡単に移動して参照できます。  

図 4. Bluetooth SDK API リファレンス 

 

SDK でサポートされている機能の詳細なリストについては、20819A1 SDK テクニカルブリーフドキュメントを参照

してください。 

3.1.4  コンフィギュレーター  

ModusToolbox ソフトウェアは、ハードウェアリソースの構成を容易にする Configurators と呼ばれるグラフィカル

アプリケーションを提供します。CYW20819 に適用できるコンフィギュレーターを以下に示します。 

• Device Configurator は、アプリケーションで使用されるペリフェラルとピンを有効化/構成するために使用され

ます。 

• Bluetooth Configurator は、アプリケーションの BLE GATT データベースを生成するために使用されます。 

次のセクションでは、BLE アプリケーション作成演習の一部としてこれらのコンフィギュレーターを使用する方法

を詳しく見ていきます。 

 

http://www.cypress.com/
http://www.cypress.com/BT-SDKTechnicalBrief
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3.2 開発キット 

図 5 に示す CYW920819EVB-02 は、CYW20819 を使用したプロトタイピングとアプリケーション開発をサポートす

る開発キットです。 

図 5. CYW920819EVB-02 評価ボード 

 

このキットは、次の主要機能をサポートしています。 

1. オンボードアンテナ付き CYW20819 キャリアボード 

2. Arduino シールドと互換性のある拡張ヘッダー 

3. CYW20819 デバイスの 1.8 V および 3.3 V 動作のサポート  

4. リカバリーボタン (オレンジ) 、リセットボタン (青) 、ユーザーボタン (黒) 、2 つのユーザーLED、アナログサ

ーミスタ、およびモーションセンサー 

5. USB-to-UART デバイスを介して CYW20819 デバイスの 2 つのシリアルインターフェース (HCI UART およびペ

リフェラル UART (PUART) ) へのアクセスを提供するオンボードマイクロ USB コネクタ。通常、HCI UART は

アプリケーションコードのダウンロードに使用され、PUART は Bluetooth スタックとアプリケーショントレー

スメッセージの印刷、または UART を介した外部デバイスへのインターフェースに使用されます。  

ユーザーガイドや回路図など、キットの詳細については、CYW920819EVB-02 Web ページを参照してください。 

  

http://www.cypress.com/
http://www.cypress.com/CYW920819EVB-02
http://www.cypress.com/CYW920819EVB-02
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4 初めての CYW20819 BLE アプリケーション  

このセクションでは、ModusToolbox IDE を使用して CYW20819 デバイス用の簡単な BLE ベースのアプリケーショ

ンを構築するための手順を説明します。Find Me Profile (FMP) と呼ばれる Bluetooth SIG 定義の標準プロファイルが

設計に実装されています。このセクションで説明する手順は次のとおりです。 

▪ パート 1：新しいアプリケーションを作成 

▪ パート 2：設計リソースの構成 

▪ パート 3：アプリケーションコードの記述 

▪ パート 4：デザインの構築、プログラミング、テスト  

これらの手順では、特定の code example (この場合は BLE_FindMe) を使用する必要があります。ただし、Code 

Example (CE) を使用する範囲は、これらの手順を実行するために選択したパスによって異なります。このドキュメ

ントでは、Code Example (CE) とアプリケーションという用語は同じ意味で使用されています。Code Example (CE) 

は、特定の目的または機能を提供する既存の ModusToolbox アプリケーションです。 

学習したい内容に応じて、これらの手順を通じて 2 つのパスを定義しました。 

パス 「Using CE directly」パス (既存の Code 

Example (CE) を直接評価)  

「Working from Scratch」パス (既存の Code Example (CE) 

を参照としてのみ使用)  

対象 ツールまたはデバイスの初心者で、すべてがどの

ように機能するかをすばやく確認したい人。 

ModusToolbox で CYW20819 ベースの Bluetooth アプリケー

ションを開発する方法をハンズオンで学びたい人。 

 

各パスで行う必要があることは、インストラクションの各パートの始めに明確に定義されています。 

ゼロから始めて、このアプリケーションノートのすべての指示に従う場合は、指示に従うときに code example を参

照として使用します。ゼロから作業することは、設計プロセスを学ぶのに役立ちますが、時間がかかります。または、

既存の code exampleを直接評価して、短時間で CYW20819アプリケーション開発フローに慣れることができます。  

どちらの場合も、まず「事前準備」と「設計について」を読む必要があります。 

4.1 事前準備 

この演習では、次のアイテムを用意してください。 

▪ PC にインストールされている ModusToolbox 1.1 以降のバージョン 

▪ CYW920819EVB-02 評価ボード 

▪ CySmart™ iOS/Android アプリ、または Immediate Alert Service (IAS) をサポートするその他の Android または

iOS アプリ。CY5677 CySmart BLE 4.2 USB ドングルにアクセスできる場合は、CySmart ホストエミュレーショ

ンツール Windows PC アプリケーションを使用することもできます。 

CySmart アプリをダウンロードするために、携帯電話で以下の QR コードをスキャンしてください。 

iOS 

 

Android 

 

4.1.1  Code Examples をダウンロード  

Code Examples は、サイプレスの GitHub サイトのリポジトリに収集されます。GitHub から PC 上の場所に

CYW20819 Code Examples リポジトリを複製またはダウンロードしてください。これを行うには、3 つの方法があ

ります。 

http://www.cypress.com/
https://www.bluetooth.org/docman/handlers/downloaddoc.ashx?doc_id=239389
http://www.cypress.com/modustoolbox
http://www.cypress.com/CYW920819EVB-02
https://itunes.apple.com/us/app/cysmart/id928939093?mt=8
https://play.google.com/store/apps/details?id=com.cypress.cysmart&hl=en
http://www.cypress.com/documentation/development-kitsboards/cy5677-cysmart-bluetooth-low-energy-ble-42-usb-dongle
http://www.cypress.com/go/cysmart
http://www.cypress.com/go/cysmart
https://github.com/cypresssemiconductorco/Code-Examples-BT-20819A1-1.0-for-ModusToolbox
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1. 図 6 に示すように、GitHub の CYW20819 Code Examples リポジトリに移動し、Clone or 

download オプションを使用して、Code Examples リポジトリを zip ファイルとしてダウンロード

してください。ダウンロードしたファイルをハードドライブ上の場所に解凍してください。このア

プローチは、Git バージョン管理システムに慣れていない場合に特に役立ちます。 

図 6. GitHub から CYW20819 Code Examples リポジトリをダウンロード 

 

2. ModusToolbox IDE で File > Import > Git > Projects from Git を選択し、ウィザードの指示に従います。これ

は標準の Eclipse 機能です。 

3. git clone または GitHub デスクトップクライアントを使用してください。 

PC にレポジトリを作成すると、BLE Find Me プロファイルの code example は、Code-Examples-BT-20819A1-1.0-

for-ModusToolbox\CYW920819EVB-02\apps\demo\BLE_FindMe のレポジトリフォルダー内にあります。この code 

example は、次のセクションで従うことを選択した開発フローに応じて、参照として使用するか、直接使用します。  

ModusToolbox IDE には、図 7 に示すように、クイックパネルのオンライン Code examples にアクセスするためのリ

ンクも用意されています。Search Online for Code Examples リンクをクリックしてください。これにより、

GitHub リポジトリへの Web ブラウザーが開き、適切なリポジトリを選択してダウンロードしてください。次に、上

記の手順を使用して、必要なリポジトリをダウンロードできます。 

図 7. Code Examples をオンラインで検索するためのクイック起動オプション 

 

http://www.cypress.com/
https://github.com/cypresssemiconductorco/Code-Examples-BT-20819A1-1.0-for-ModusToolbox
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4.2 設計について 

この設計は、Immediate Alert Service (IAS) で構成される BLE Find Me Profile (FMP) を実装しています。FMP と IAS

は、それぞれ Bluetooth SIG で定義されている BLE 標準プロファイルとサービスです。この設計では、

CYW920819EVB-02 キットの 2 つの LED (赤色 LED、黄色 LED) を使用しています。赤色 LED (LED2) は IAS アラー

トレベルを表示します - アラートなし (LED オフ) 、軽度のアラート (LED 点滅) 、高アラート (LED オン) 。黄色の

LED (LED1) は、周辺機器 (CYW20819) が通知 (LED 点滅) 、接続 (LED オン) 、または切断 (LED オフ) しているかを

示します。さらに、デバッグ UART インターフェースは、Bluetooth スタックとアプリケーショントレースメッセー

ジの送信に使用されます。 

iOS / Android モバイルデバイスまたは PC は、周辺機器に接続する BLE セントラルデバイスとして機能できます。 

図 8. CYW20819 を使用した Find Me Profile (FMP) アプリケーション 

 

4.3 パート 1：新しいアプリケーションを作成 

このパートでは、新しい ModusToolbox アプリケーションを作成するプロセスをステップごとに説明します。このセ

クションの手順を実行する前に、code example をそのままインポートして実行するか、アプリケーションを最初か

ら作成する方法を学ぶかを決定します。選択に応じて、実行する必要がある手順は次のとおりです。 

パス 「Using CE directly」パス (既存の Code Example 

(CE) を直接評価)  

「Working from Scratch」パス (既存の Code Example (CE) 

を参照としてのみ使用)  

アクシ

ョン 

手順 1、2、3、4 を実行してください。手順 5 は無視し

てください。 

手順 1、2、3、5 を実行してください。手順 4 は無視してく

ださい。 

 

ModusToolbox を起動して開始してください。 

1. 新しいワークスペースを選択してください。 

起動時に、ModusToolbox は、ワークスペースディレクトリとして使用するディレクトリを選択するダイアログ

を表示します。ワークスペースディレクトリは、ワークスペース環境設定と、デバイス構成やアプリケーション

ソースコードなどの開発成果物を格納するために使用されます。図 9 に示すように、Browse ボタンをクリック

して、既存の空のディレクトリを選択できます。または、ワークスペースディレクトリとして使用するディレク

トリ名と完全なパスを入力すると、ModusToolbox がディレクトリを作成します。 

http://www.cypress.com/
https://developer.bluetooth.org/gatt/services/Pages/ServiceViewer.aspx?u=org.bluetooth.service.immediate_alert.xml
https://www.bluetooth.org/docman/handlers/downloaddoc.ashx?doc_id=239389
https://www.bluetooth.com/
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図 9. ワークスペースとしてディレクトリを選択 

 

  

http://www.cypress.com/
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2. 新しい ModusToolbox アプリケーションを作成してください。 

クイックパネルの [Start]グループで New Application をクリックしてください。または、File > New > 

ModusToolbox IDE Application を選択することもできます (図 10) 。 

ModusToolbox IDE アプリケーションウィンドウが表示されます。 

図 10. 新しい ModusToolbox IDE アプリケーションを作成する 

 

  

http://www.cypress.com/
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3. CYW20819 ベースのターゲットハードウェアを選択してください。 

ModusToolbox は、アプリケーション開発を開始するためのサイプレスキットのリストを表示します。今回は、

CYW20819 デバイスを利用した CYW920819EVB-02 評価ボード上でのアプリケーション開発を行いたいと思い

ます。CYW920819EVB-02 を選択し、Next をクリックしてください (図 11) 。 

図 11. ターゲットハードウェアを選択 

 

カスタムボードオプションに関する注意：CYW20819デバイスに基づくカスタムボードがある場合は、Custom 

Boardを選択し、Next をクリックしてください。リストから適切な CYW20819デバイスを選択して、先に進み

ます。このアプリケーションノートでは「Custom Board」開発フローを使用していませんが、以下の手順は

「Custom Board」開発フローのガイドとしても使用できます。  

4. BLE_FindMe Code Example をインポートしてください (「CE を直接使用する」フローにのみ適用されます)  

Import オプションは、リポジトリからダウンロードした、または同僚から受け取った code example を

ModusToolbox IDE にインポートするのに役立ちます。この機能を使用して、Using CE directly フローの

BLE_FindMe code example をインポートします。図 12 に示す Starter Application ダイアログで、Import をク

リックし、前にダウンロードした CE リポジトリの BLE_FindMe code example の場所 (Code-Examples-BT-

20819A1-1.0-for-ModusToolbox\CYW920819EVB-02\apps\demo\BLE_FindMe) に移動します。code example フ

ォルダー内の modus.mk を選択してください。BLE_FindMe example の名前と説明が Starter Application ダイ

アログに表示されます。必要に応じてアプリケーション名を変更してください。CE226123 は図 12 で使用され

ている名前です。Next をクリックし、Finish をクリックして (図 13) 、アプリケーションの作成プロセスを完了

してください。 

http://www.cypress.com/
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図 12. BLE_FindMe Code Example のインポート 

 

図 13. アプリケーションの概要 

 

CYW20819 用の新しい ModusToolbox アプリケーションが正常に作成されました。  

5. スターターアプリケーションを選択してアプリケーションを作成してください (「Working from Scratch」フ

ローにのみ適用されます)  

Working from Scratch 開発フローの開始点として、既存のテンプレートアプリケーションを使用していただきま

す。図 14 に示す Starter Application ダイアログで、EmptyWicedBluetooth を選択してください。Name フィ

ールドに、アプリケーションの名前 (この場合は CE226123) を入力して、Next をクリックしてください。アプ

リケーションの要約ダイアログが表示されます。Finish をクリックして (図 15) 、ModusToolbox にアプリケー

ションを作成してください。 

http://www.cypress.com/
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図 14. スターターアプリケーションウィンドウ 

 

図 15. アプリケーションの概要 

 

CYW20819 用の新しい ModusToolbox アプリケーションが正常に作成されました。  

  

http://www.cypress.com/
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4.4 パート 2：設計リソースの構成  

このステップでは、アプリケーションの設計リソースを構成し、構成コードを生成します。 

パス 「Using CE directly」パス (既存の Code Example (CE) を

直接評価)  

「Working from Scratch」パス (既存の Code 

Example (CE) を参照としてのみ使用)  

アクシ

ョン 

すべてのステップを読んで理解してください。CE はすでに

すべてのリソース構成を完了しているため、このセクション

の手順を実行する必要はありません。  

すべてのステップを行う 

 

EmptyWicedBluetooth アプリケーションテンプレートには、CYW902819EVB-02 キットで利用可能なすべてのリ

ソースが事前設定されており、すぐに使用できます。これらのリソースには、ユーザーLED、プッシュボタン、通信

ペリフェラル (Bluetooth、UART、I2C、SPI) が含まれます。テンプレートアプリケーションには、デバイスと

Bluetooth スタックを初期化し、Peripheral UART (PUART) インターフェースにステータスメッセージを出力するデ

フォルトのアプリケーションコードスニペットも含まれています。 

先に進む前に、ModusToolbox プロジェクトエクスプローラーのクイックツアーが用意されています。図 16 は、テ

ンプレートアプリケーションが作成された直後の ModusToolboxプロジェクトエクスプローラービューを示していま

す。  

図 16. プロジェクトエクスプローラービュー 

 

▪ Includes フォルダーには、Bluetooth スタック、hardware abstraction layer (HAL) 、ハードウェアプラットフォー

ムなどに関連するヘッダーファイルが含まれています。API 関数のプロトタイプ、定数、およびデフォルトは、

これらのヘッダーファイルに含まれています。記述するアプリケーションコードは、必要に応じてこれらの API

関数と定数を使用します。 

▪ bt_20819A1-1.0 フォルダーには、追加のソース/ヘッダーファイルが含まれています。このフォルダーツリーの

spar_setup.c フ ァ イ ル に は 、 デ バ イ ス の ス タ ー ト ア ッ プ コ ー ド の 一 部 と し て 実 行 さ れ る

application_start_internal()関数が含まれています。この関数は、ハードウェアプラットフォームのデフ

ォルトの初期化ルーチン (wiced_platform_init()) を呼び出してから、application_start()関数を呼び出し

ます。application_start()関数は、ユーザーアプリケーションコードのエントリポイントです。このテンプ

レートプロジェクトでは、関数は empty_wiced_bt.c ファイルにあります。 

http://www.cypress.com/
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▪ GeneratedSource フォルダーには、このアプリケーションの設計構成が含まれています。これには、アプリケー

ションに対して有効化/無効化されたリソースのリスト、およびさまざまなリソースの構成設定が含まれます。

このフォルダーの内容については、アプリケーション開発フローの次のステップで詳しく説明します。   

▪ design.modus ファイルは、アプリケーションのハードウェアリソース構成設定を含むグラフィカルコンフィギ

ュレーター設計ファイルです。このファイルは、GeneratedSource フォルダー内の構成ファームウェアファイル

を生成/変更するグラフィカルコンフィギュレーターによって使用されます。このファイルの詳細については、

アプリケーション開発フローの次のステップで説明します。   

▪ empty_wiced_bt.c ファイルには、デバイスの起動後にユーザーアプリケーションコードを実行するためのエント

リポイントである application_start()関数が含まれています。また、Bluetooth スタック管理イベントハンド

ラー関数も含まれています。後で確認する場合は、このファイルの名前を変更できます。 

▪ app_bt_cfg.c および app_bt_cfg.h ファイルには、デバイス名などのランタイム Bluetooth スタック構成パラメー

ター、およびアドバタイズ/接続設定が含まれています。 

▪ wiced_platform.c、wiced_platform.h ファイルには、キットで使用される LED、ボタン、センサーなど、ハード

ウェアプラットフォーム (この場合は CYW920819EVB-02) の初期化に関連する関数とマクロ定義が含まれてい

ます。  

▪ modus.mk ファイルは、デザインを記述する最上位の Makefile であり、IDE によって作成および使用されます。

ビルドシステムに渡されるアプリケーションのデザイン make 変数が含まれています。このファイルは、アプリ

ケーションの設定やミドルウェアの選択の変更など、特定の操作中に IDE によって変更されます。このファイル

を編集する必要はありません。このドキュメントでは、このファイルの詳細については説明しません。 

▪ 20819_readme.txt ファイルには、デバイスの機能、利用可能な評価キット、CYW20819 デバイスの SDK 機能、

利用可能なソフトウェアツール、およびアプリケーション設定の詳細に関する情報が含まれています。 

▪ readme.txt ファイルには、アプリケーションの機能を説明する情報が含まれています  (この場合は、

EmptyWicedBluetooth) 。 

▪ makefile.init はビルドプロセスの一部として使用されます。これにより、上級ユーザーはビルドフローで新しい

ルールと変数を指定できます。 

それでは、テンプレートアプリケーションでデザインリソースを構成する方法の詳細を見ていきましょう。 

1. ハードウェアリソースの構成 

EmptyWicedBluetooth テンプレートアプリケーションからアプリケーションをセットアップしたので、このア

プリケーションに必要なハードウェアリソースを構成し、対応する構成コードを生成します。ModusToolbox 

IDE は、アプリケーションの構成設定を design.modus ファイルに保存します。このファイルは、構成ファーム

ウェアを生成するグラフィカルコンフィギュレーターによって使用されます。このファームウェアは、アプリケ

ーションの GeneratedSource フォルダーに格納されています。 

Device Configurator は、アプリケーションで使用されるペリフェラルとピンを有効化/構成するために使用され

ます。Device Configurator を起動するには、design.modus ファイルをダブルクリックするか、図 17 に示すよう

に、クイックパネルで Configure Device をクリックしてください。DeviceConfigurator で変更を行うたびに、

File > Save をクリックして、更新された構成を保存してください。 

http://www.cypress.com/
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図 17. クイックパネルビュー 

 

図 18 は、このアプリケーションの Peripherals ビューを示す Device Configurator ビューを示しています。  

図 18. Device Configurator- Peripherals 

 

A 
B 

http://www.cypress.com/
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• Peripherals：テンプレートアプリケーションでは、図 18 に示すように、キットのペリフェラルがデフォルトで

有効になっています (Bluetooth、I2C、SPI 1、UART 2) 。Find Me アプリケーションでは、Bluetooth および

PUART (UART 2) ペリフェラルのみが使用されます。ただし、テンプレートアプリケーションでのデフォルト

のペリフェラルの有効化/無効化設定はそのままにしておくことができます。I2C と SPI はコードで有効化されな

いため、コンフィギュレーターで有効化してもかまいません。 

ペリフェラルを設定するには、Resource ペインでペリフェラル名をクリックしてください。 Parameters ペイ

ンには、そのペリフェラルに提供されている構成オプションが表示されます。 Device Configurator の詳細につ

いては、Help -> View Help を選択して、Configurator のドキュメントを開いてください。 

• Bluetooth Configurator：Bluetooth ペリフェラルには、Bluetooth Configurator と呼ばれる追加のコンフィギュ

レーターがあり、アプリケーションの BLE GATT データベースを生成するために使用されます。Find Me Profile

アプリケーションの場合、CYW20819 デバイスの Find Me Target ロールに対応する GATT データベースを生成

する必要があります。Device Configurator ウィンドウから Bluetooth Configurator を起動するには、Peripherals

セクションの下の Bluetooth リソースをクリックし、次に Bluetooth-Parameters ウィンドウの下の Launch 

Bluetooth Configurator ボタンをクリックしてください (図 18 のコールアウト A および B を参照) 。Bluetooth 

Configurator のデフォルトビューを図 19 に示します。 

 

図 19. Bluetooth Configurator 

 

Find Me Target プロファイルを追加するには、GATT プロファイル (図 19 の A) をクリックし、次に+アイコン 

(図 19のB) をクリックしてください。図 20に示すように、ドロップダウンメニューからFind Me Target (GATT 

Server) プロファイルを選択してください。  

図 20. Find Me ターゲットプロファイルの追加 

 

A 

 

B   

 

http://www.cypress.com/
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図 21 は、Find Me Target Server が追加された後の GATT データベースビューを示しています。Find Me Target

プロファイルに対応する Immediate Alert Service が図  21 に追加されていることに注意してください。

[Configurator]ウィンドウで File > Save をクリックするか、[保存]アイコンをクリックしてください。 コンフィ

ギュレーターは、GATT データベースを GeneratedSource フォルダーのソースファイル cycfg_gatt_db.h、

cycfg_gatt_db.h に保存してください。 同じフォルダー内の cycfg_bt.h ファイルには、XML 形式の Bluetooth コ

ンフィギュレーター設定が含まれており、コンフィギュレーターは、起動時に設定をロードするために使用しま

す。 

図 21. 最終的な GATT データベースビュー 

 

• Pins：アプリケーションで使用されるピンは、図 22 に示すように、デバイスコンフィギュレーターの Pins

セクションで有効になります。テンプレートアプリケーションには、LED、ボタン、I2C、SPI、PUARTなどの

ペリフェラルに使用されるピンなど、キットの機能に対応したいくつかのピンがすでに有効化され、設定さ

れています。Find Me アプリケーションの場合、対象となるピンは 2 つの LED ピン (LED1、LED2) と

PUART インターフェースピン (UART_TX、UART_RX) です (表 1 を参照) 。これらのピンのパラメーター

設定は、図 23、図 24、図 25、および図 26 に示すようにデフォルト設定のままにします。SPI および I2C

ピンは変更しません。これらのピンは他の目的には使用しません。そのため、使用しているボードのデフォ

ルトのペリフェラルにピンを割り当てても問題ありません。Device Configurator で変更を行うときはいつで

も、File > Save をクリックするか、[Save]アイコンをクリックして、更新された構成を保存してください。 
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図 22. デバイスコンフィギュレーター-ピン 

 

 

表 1. ピンマッピングの詳細 

端子  エイリアス 用途 設定 

P26 LED2 
キットの赤色 LED (LED2) にマッピングされています。IAS 警

告レベルを示します。 

図 23 と図 24 を参照してください。図に示す

ように、各 LEDのインデックス設定が異なる

ことを確認してください。コンフィギュレータ

ーはこのチェックを行いません。インデックス

値も 1 から開始する必要があります (0 ではあ

りません) 。インデックス値が構成コードによ

ってどのように使用されるかを確認するには、

cycfg_pins.h を参照してください。  

P27 LED1 
キットの黄色の LED (LED1) にマッピングされています。BLE

周辺機器の Advertising / Connected 状態を示します。 

P32 PUART_TX PUART ペリフェラルの Txピン  図 25 を参照してください。 

P37 PUART_RX PUART ペリフェラルの Rxピン 図 26 を参照してください。 
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図 23. LED1 ピン設定 

 

図 24. LED2 ピン設定 

 

図 25. PUART Tx ピン設定 

 

図 26. PUART Rx ピン設定 

 

これでアプリケーションのリソース構成が完了し、必要な構成コードが GeneratedSource フォルダーのファイルに

生成され、設定も design.modus ファイルに保存されました。 
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2. アプリケーション設定の構成 

アプリケーション設定は、Bluetooth デバイスアドレス、アプリケーションをダウンロードするためのシリアル

ポート番号の指定、デバッグの有効化など、さまざまなプロジェクト設定です。図 27 に示すように、プロジェ

クトエクスプローラーで最上位のプロジェクト名を右クリックし、Change Application Settings を選択すると、

アプリケーション設定を表示または変更できます。 

図 27. アプリケーション設定ダイアログを起動 

 

図 28 は、テンプレートアプリケーションのアプリケーション設定を示しています。ここで注意すべき点の 1 つ

は、BT_DEVICE_ADDRESS パラメーターが AUTO 設定に設定されていることです。これは、SDK がデバイス

にランダムな Bluetooth デバイスアドレスを設定することを意味します。さまざまなパラメーターの意味を理解

するには、20819_readme.txt ファイルの「Application Settings」セクションを参照してください。アプリケーシ

ョン設定を変更すると、IDE は modus.mk ファイルも自動的に変更して、更新された設定を反映することに注意

してください。 

図 28. アプリケーションの設定 
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3. ミドルウェアセレクター 

ModusToolbox の Bluetooth SDK には、「Middleware Selector」ダイアログがあり、Bluetooth アプリケーショ

ンを開発するためのさまざまなミドルウェアコンポーネントを選択できます。[Middleware Selector]ダイアログ

を起動するには、プロジェクトエクスプローラーで最上位のプロジェクト名を右クリックし、ModusToolbox 

Middleware Selector オプションを選択してください (このオプションについては、図 27 を参照してください) 。

または、クイックパネルの Select Middleware リンクをクリックすることもできます。図 29 は、テンプレート

アプリケーションの[Middleware Selector]ダイアログを示しています。  

Find Meアプリケーションでは、これらのライブラリは使用しませんが、リポジトリ内の他の Code examplesを

参照して、特定のライブラリの使用方法を理解できます。たとえば、ビーコンの code example では、

beacon_lib および fw_upgrade_lib ミドルウェアコンポーネントを使用しています。Middleware Selector で選択

を行うと、modus.mk ファイルが自動的に更新され、それらのミドルウェアコンポーネントが関連する make 変

数に含まれることに注意してください。ミドルウェアを選択するために modus.mkファイルを手動で編集する必

要はありません。  

図 29. Middleware Selector 
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4.5 パート 3：アプリケーションコードの記述 

開発プロセスのこの時点で、アプリケーションを作成し、ハードウェアリソースを構成し、BLE GATT データベース

を含む構成コードを生成しました。このパートでは、Find Me Target 機能を実装するアプリケーションコードを調べ

ます。 

パス 「Using CE directly」パス (既存の Code Example (CE) を

直接評価)  

「Working from Scratch」パス (既存の Code 

Example (CE) を参照としてのみ使用)  

アクシ

ョン 

手順 1 は無視してください。CE には必要なソースファイル

がすべて追加されています。ファームウェアの説明セクショ

ンを読んで、ファームウェアの設計を理解してください。 

ステップ 1 を実行してください。ファームウェアの説明

を読み、ファームウェアの設計を理解してください。 

 

アプリケーションコードは、以下に示す主要なタスクを実行する必要があります。 

▪ Bluetooth スタックを含むシステム初期化を実行してください。 

▪ アドバタイズ、接続、属性の読み取り/書き込み要求などのさまざまなイベントの Bluetooth スタックイベントハ

ンドラー関数を実装してください。 

▪ ユーザーインターフェースロジックを実装して、トリガーされたイベントに基づいてキットの LED 状態を更新

してください。 

コードの理解を容易にし、コードの再利用を可能にするために、上記の各タスクが個別のソース /ヘッダーファイル

に含まれるモジュール式ファームウェア開発アプローチを使用します。 

1. プロジェクトにファイルを追加する (「Working from Scratch」フローでのみ必要)  

A. リポジトリからダウンロードした BLE_FindMe code example を見つけます。リポジトリのダウンロードプ

ロセスとコード例の場所の詳細については、「事前準備」セクションを参照してください。 

B. 以下のファイルを BLE_FindMe code example の最上位フォルダーから ModusToolbox ワークスペースフォ

ルダー内の AppName_mainapp フォルダー (CE226123\mtw\CE226123_mainapp) にコピーしてください。

OS のネイティブファイルエクスプローラーアプリケーションを使用して、既存のファイルを置き換えます。

または、ModusToolbox IDE プロジェクトエクスプローラーウィンドウの inapp フォルダーにファイルをド

ラッグ/ドロップすることもできます。 

• main.c 

• app_bt_event_handler.c 

• app_bt_event_handler.h 

• app_bt_cfg.c 

• app_bt_cfg.h 

• app_user_interface.c 

• app_user_interface.h 

• modus.mk 

C. empty_wiced_bt.c ファイルを ModusToolbox IDE プロジェクトエクスプローラーまたは PC ファイルエクス

プローラーから削除してください。同等の application_start()関数が前のステップでコピーされた

main.c ファイルの一部になっているため、このファイルは不要になりました。 
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4.6 ファームウェアの説明 

このセクションでは、Find Meアプリケーションのアプリケーションファームウェアについて説明します。このcode 

example のユーザーアプリケーションレベルのコードに関連する重要なソースファイルを表 2 に示します。 

表 2. 重要なユーザーアプリケーション関連のソースファイル 

ファイル名 備考 

cycfg_gatt_db.c、
cycfg_gatt_db.h 

これらのファイルは、アプリケーションフォルダーの下の GeneratedSource フォルダーにありま

す。これらには、Bluetooth Configurator ツールを使用して生成された GATT データベース情報が

含まれています。 

app_bt_cfg.capp_bt_cfg.h これらのファイルには、デバイス名などのランタイム Bluetooth スタック構成パラメーター、およ

びアドバタイズメント/接続設定が含まれています。 

main.c デバイスの起動後にユーザーアプリケーションコードを実行するためのエントリポイントである

application_start()関数が含まれます。 

app_bt_event_handler.c 
app_bt_event_handler.h 

これらのファイルには、Bluetooth スタックイベントハンドラー関数のコードが含まれています。  

app_user_interface.c 
app_user_interface.h 

これらのファイルには、アプリケーションユーザーインターフェース (この場合は LED) 機能のコ

ードが含まれています。 

 

4.6.1  BLE GATT データベース   

cycfg_gatt_db.c および cycfg_gatt_db.h ファイルには、Bluetooth Configurator ツールを使用して前のステップで生成

された Find Me Target プロファイルの BLE GATT データベース定義が含まれています。GATT データベースは、

Bluetooth スタックとアプリケーションコードの両方からアクセスされます。スタックは、属性ハンドル、UUID、お

よび属性アクセス許可に直接アクセスして、Bluetooth イベントの一部を処理します。アプリケーションコードは

GATT データベースにアクセスして、属性の読み取り/書き込み操作を実行します。関連するデータベース構造を以

下に示します。 

• gatt_database[]：この配列には、属性ハンドル、タイプ、および権限が含まれています。この配列には、以

下で説明するように個別の配列として保持される実際の属性値は含まれないことに注意してください。  

• GATT Value Arrays：属性値を含む実際の GATT データベースは、cycfg_gatt_db.c の GATT Initial Value 

Arraysセクションで一連の uint8_t配列として宣言されます。これらの配列は、cycfg_gatt_db.hファイルでア

プリケーションコードにアクセスするための外部変数としても公開されます。FMP ターゲットアプリケーショ

ンには、app_gap_device_name[]、app_gap_appearance[]、および app_ias_alert_level[]という名前で

定義されたこれらの配列があります。app_ias_alert_level[]は、クライアントがアラートレベルを設定する

ために書き込む IASサービスに対応するアラートレベル特性です。この属性への実際の書き込みは、アプリケー

ションコードによって実行されます。 

• app_gatt_db_ext_attr_tbl[]：この構造体の配列は、gatt_database[]で定義されている属性ハンドルの

GATT value arrays へのマッピングを伝達する GATT ルックアップテーブルです。アプリケーションコードは

このルックアップテーブルを使用して、実際の GATT arrays に対して属性の読み取り/書き込み操作を実行しま

す。 

4.6.2  Bluetooth スタック構成パラメーター  

app_bt_cfg.c および app_bt_cfg.h ファイルには、デバイス名 (BT_LOCAL_NAME) 、コアスタック構成パラメーター 

(wiced_bt_cfg_settings[]) 、 お よ び ス タ ッ ク で 使 用 さ れ る メ モ リ ー バ ッ フ ァ ー プ ー ル 

(wiced_bt_cfg_buf_pools[]) などのランタイム Bluetooth スタック構成パラメーターが含まれています。このアプ

リケーションノートの範囲では、これらのパラメーターについては説明しません。ただし、これらのパラメーターに

ついては、ソースファイルのコメントを参照してください。BT_LOCAL_NAME 変数で定義されたデバイス名は、接続

を確立するデバイスを識別するためにピアデバイス側で使用されるものであることに注意してください (この場合は、

「Find Me Target」) 。 
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4.6.3  ユーザーアプリケーションコードの入力  

main.c ファイルには、application_start()関数が含まれています。この関数は、デバイスの初期化が完了した後

にユーザーアプリケーションコードを実行するためのエントリポイントです。この code example では、この関数は

2 つのことを行います。 

• PUART シリアルポートをデバッグ UART として選択して、トレースメッセージを表示し、WICED_BT_TRACE 関

数を使用してデバッグ UARTに起動メッセージを出力してください。WICED_BT_TRACE関数は、スプリントタイ

プのフォーマットを使用してメッセージを送信するために使用されます。 

• wiced_bt_stack_init()を呼び出して、Bluetooth スタックマネージメントコールバック関数を登録してくださ

い。スタックマネージメントコールバック関数は、通常、Bluetooth イベントに基づいてアプリケーションの残

りの部分を制御します。通常、application_start()関数では、最小限のアプリケーション初期化のみが行わ

れます。Bluetooth スタックが有効になると、ほとんどのアプリケーション初期化はスタックコールバック関数

で行われます。スタックコールバック関数 app_bt_management_callback は、app_bt_event_handler.c で定義

されています。コールバック関数は、特定のイベントが発生したときに別の関数によって呼び出される関数です。 

4.6.4  Bluetooth スタックイベント  

app_bt_event_handler.cおよび app_bt_event_handler.hファイルには、スタックによって生成されるさまざまなタイ

プのイベントを処理するためのアプリケーションコードロジックが含まれています。大まかに言うと、処理する必要

のあるイベントには、Bluetooth スタックマネージメントイベントと GATT イベントの 2 つのカテゴリがあります。 

4.6.4.1 スタックマネージメントイベント  

コールバック関数 app_bt_management_callback は、スタック有効化、アドバタイズメントの状態変更、ペアリン

グなどのセキュリティ関連イベント、キー交換などのイベントを処理します。このコールバック関数は、main.c の

application_start()関数の一部として登録されます。マネージメントイベントのリストについては、

wiced_bt_dev.h の wiced_bt_management_evt_t 定義を参照してください。アプリケーションコードがすべてのマ

ネージメントイベントを処理する必要はありません。処理されるイベントは、アプリケーションの要件によって異な

ります。図 30 は、この code example のスタックマネージメントイベントハンドラーの実行ロジックを示していま

す。図  30 に示すように、スタックマネージメントコールバック関数では、2 つのマネージメントイベント 

(BTM_ENABLED_EVT および BTM_BLE_ADVERT_STATE_CHANGED_EVT) のみが処理されます。  
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図 30. Bluetooth スタック管理イベントハンドラーの機能フロー 
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この時点で、BTM_ENABLED_EVT について説明することが適切です。これは、すべての CYW20819 ベースのアプ

リケーションで処理する必要がある重要なマネージメントイベントであり、Bluetooth スタックが有効になっている

ことを示しています。すべてのアプリケーションコードの初期化は、図 30 に示すように、ble_app_init()関数を

呼び出して Bluetooth スタックが正常に有効化された後にのみ行われます。 

app_bt_event_handler.c で定義されている ble_app_init()関数は、以下に示す初期化タスクを実行します。作成す

る CYW20819 ベースのアプリケーションでは、この関数に必要な初期化コードを追加する必要があります。 

▪ app_user_interface.c で定義されている app_user_interface_init()を呼び出して、ユーザーインターフェー

ス (LED) ロジックを初期化してください。 

▪ wiced_bt_set_pairable_mode()を呼び出してペアリングを無効にしてください。このアプリケーションでは、

ペアリング機能は使用されません。 

▪ app_bt_event_handler.c で定義されている ble_app_set_advertisement_data()を呼び出して、アドバタイズ

パケットデータを設定してください。code example のこの関数定義を見て、アドバタイズパケットの要素を構

成する方法を理解してください。 

▪ wiced_bt_gatt_register() を 呼 び 出 し て 、 GATT イ ベ ン ト を 処 理 す る コ ー ル バ ッ ク 関 数 

(ble_app_gatt_event_handler()) を登録してください。 

▪ wiced_bt_gatt_db_init()を呼び出して、 cycfg_gatt_db.c で定義されている GATT データベース 

(gatt_database) を初期化してください。 
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▪ 初期化プロセスの最後のステップとして、デバイスは関数 wiced_bt_start_advertisements()を呼び出してア

ドバタイズを開始します。 
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4.6.4.2 GATT イベント  

ble_app_gatt_event_handler()関数は、接続や属性要求イベントなどの GATT イベントを処理します。この関数

は、app_bt_event_handler.c の ble_app_init()関数から wiced_bt_gatt_register()を呼び出して登録されます

。GATTイベントのリストについては、wiced_bt_gatt.hの wiced_bt_gatt_evt_t定義を参照してください。アプリ

ケーションコードがすべてのGATTイベントを処理する必要はありません。処理されるイベントは、アプリケーショ

ンの要件によって異なります。図 31 は、この code example の GATT イベントハンドラーの実行ロジックを示して

います。図  31 に示すように、関数では 2 つの GATT イベント  (GATT_CONNECTION_STATUS_EVT と

GATT_ATTRIBUTE_REQUEST_EVT) のみが処理されます。  

図 31. GATT イベントハンドラー 
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1.) Updates the state variables bt_connection_id,

app_bt_adv_conn_state. 

2.) In case of disconnection, turn off IAS alert level LED, and  

restart the advertisements wiced_bt_start_advertisements()) 

3.) Update the Advertisement LED to reflect the current

connected/advertising states

Call ble_app_server_callback() function to process GATT 

attribute request. This function does below things.

1.) Calls ble_app_write_handler() to handle attribute write 

request. This function in turn calls ble_app_set_value() which 

does the actual write to the GATT database

2.) Calls ble_app_read_handler() to handle attribute read 

request. This function in turn calls ble_app_get_value() which 

does the actual read from the GATT database

GATT Event Defines

 used in the code

Set status variable as 

success for unhandled 

events

Return from GATT event 

handler

Enter ble_app_gatt_event_handler() function

No

Bluetooth Stack

User Application Code

Yes

Yes

 

この時点で、GATT_ATTRIBUTE_REQUEST_EVT について議論することが適切です。このイベントは、GATT 属性の読

み取り/書き込み操作を処理するために使用されます。図 32 は、読み取りまたは書き込み操作の場合に呼び出される

関数に関する情報を示しています。この code example では、Find Me Locator が CYW20819 デバイスの IAS アラー

トレベル特性を更新すると、GATT_ATTRIBUTE_REQUEST_EVT がトリガーされ、属性の書き込み要求に関連する一連

の 関 数 が 呼 び 出 さ れ ま す 。 書 き 込 み 操 作 の 最 後 に 、 cycfg_gatt_db.c の GATT デ ー タ ベ ー ス の

app_ias_alert_level[]関数が、Find Me Locator によって設定されたアラートレベルで更新され、LEDがアラート

レベルに適切に設定されます。 

図 32 は、このアプリケーションのさまざまなスタックイベントの関数呼び出しのシーケンスをまとめた関数呼び出

しチャートを示しています。これらすべての関数 (adv_led_update()を除く) は、app_bt_event_handler.c で定義さ

れています。これらの関数の実装の詳細を理解するには、ソースコードを参照してください。 
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図 32. Bluetooth スタックイベント関数呼び出しチャート 
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4.6.5  ユーザーインターフェースロジック  

app_user_interface.c および app_user_interface.h ファイルには、ユーザーインターフェースロジックを処理するた

めのアプリケーションコードが含まれています。このデザインでは、ユーザーインターフェースに 2 つの LED を使

用しています。 

▪ キットの LED1 (黄色の LED) は、BLE 周辺機器のアドバタイズ/接続状態を示すために使用されます。LED1 は、

デバイスがアドバタイズしていないときはオフ状態、アドバタイズ中は点滅している状態、ピアデバイスに接続

されているときは常にオン状態です。実装の詳細については、adv_led_update()関数を参照してください。グ

ローバル状態変数 app_bt_adv_conn_state は、LED 状態を更新するために使用されます。adv_led_update()

関数は、アプリケーションコードの 2 つの場所から呼び出されます。 

• app_bt_management_callback()関数は、通知状態が変化すると LED1 を更新します (スタックマネージメン

トイベント BTM_BLE_ADVERT_STATE_CHANGED_EVT)  

• ble_app_connect_callback()関数は、接続状態が変化すると LED1 を更新します  (GATT イベント
GATT_CONNECTION_STATUS_EVT)  

▪ キットの LED2 (赤色 LED) は、デバイスがピアデバイスに接続されているときの IAS アラートの特性レベルを示

すために使用されます。ピアデバイスに接続されている場合、LED2 は、低アラートの場合はオフ状態、中アラ

ートの場合は点滅状態、高アラートの場合はオン状態になります。デバイスがピアデバイスに接続されていない

場合、LED2 はオフの状態です。実装の詳細については、ias_led_update()関数を参照してください。

adv_led_update()関数は、アプリケーションコードの 2 つの場所から呼び出されます。 

• クライアント側から IAS アラートレベル特性への属性書き込み要求が行われると、ble_app_set_value () 関数

は LED2 を更新します。 

• ble_app_set_value()関数は、切断が発生したときに LED2 をオフ状態に駆動します (GATT イベント
GATT_CONNECTION_STATUS_EVT)  
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4.7 パート 4：デザインの構築、プログラミング、テスト 

このセクションでは、CYW920819EVB-02 キットでアプリケーションを構築し、CYW20819 デバイスをプログラム

する方法を示します。また、CySmart モバイルアプリを使用して Find Me Profile BLE デザインをテストし、PUART

シリアルインターフェースを使用して Bluetooth スタックとアプリケーショントレースメッセージを表示する方法に

ついても説明します。  

この時点では、このアプリケーションノートの前の手順に従って Find Me Profileアプリケーションを開発しているこ

とを前提としています。 

パス 「Using CE directly」パス (既存の Code Example (CE) を

直接評価)  

「Working from Scratch」パス (既存の Code 

Example (CE) を参照としてのみ使用)  

アクシ

ョン 

このセクションのすべての手順を実行してください このセクションのすべての手順を実行してください 

 

1. 付属の USB ケーブルを使用してキットを PC に接続してください。 

2. キットの USB シリアルインターフェースは、CYW20819 デバイスの 2 つの UART インターフェース (WICED 

HCI UART と WICED ペリフェラル UART (PUART) ) へのアクセスを提供します。HCI UART インターフェース

は、この code example のアプリケーションコードをダウンロードするためにのみ使用されます。PUART イン

ターフェースは、Bluetooth スタックとアプリケーショントレースメッセージを出力するためのものです。お気

に入りのシリアルターミナルアプリケーションを使用して、PUART シリアルポートに接続してください。次の

設定を使用して、シリアルポートにアクセスするようにターミナルアプリケーションを設定してください。 

Baud rate: 115200 bps; Data: 8 bits; Parity: None; Stop: 1 bit; Flow control – None; New line for receive data: Line 
Feed (LF) or Auto setting  

3. アプリケーションのビルドとプログラミング：プロジェクトエクスプローラーで、< App Name > _mainapp 

project を選択してください。クイックパネルで、Launches セクションまでスクロールして、図 33 に示すよう

に <App Name> Build + Program 構成をクリックしてください。 

図 33. ModusToolbox からの CYW20819 デバイスのプログラミング 

 

注 1：ダウンロードが失敗した場合、以前にロードされたアプリケーションがプログラミングを妨げている

可能性があります。たとえば、アプリケーションがダウンロードプロセスで検出されないカスタムボーレー

トを使用している場合や、デバイスが低電力モードになっている場合があります。その場合、ボードをリカ

バリーモードにして、IDE からプログラミング操作を再試行する必要がある場合があります。リカバリーモ

http://www.cypress.com/


  CYW20819 入門 

www.cypress.com Document Number: 002-25684 Rev. ** 34 

 TRANSLATED BY COMMUNITY 

ードに入るには、最初に Recover ボタン (SW1) を押し続けてから、Reset ボタン (SW2) を押し、Reset

ボタン (SW2) を離し、次に Recover ボタン (SW1) を離してください。 

注 2：アプリケーションのビルドプロセスでエラーが発生した場合は、IDE コンソールウィンドウのエラー

メッセージを読み、このドキュメントの関連する前の手順に戻って、これらの手順のいずれかを実行してい

ないか、誤って実行していないかどうかを確認してください。  

4. CySmart モバイルアプリを使用してテストするには、以下の手順に従います (iOS の場合は図 34、Android の場

合は図 35 の同等の CySmart アプリのスクリーンショットを参照してください) 。 

a. Android または iOS デバイスで Bluetooth をオンにしてください。 

b. CySmart アプリケーションを起動してください。 

c. CYW920819EVB-02 キットのリセットスイッチを押して、アドバタイズメントの送信を開始してください。

黄色の LED (LED1) が点滅し始め、広告が開始されたことを示します。接続が確立されていない場合、アド

バタイズは 90 秒後に停止します。 

d. CySmartアプリのホーム画面を下にスワイプして、BLEペリフェラルのスキャンを開始してください。デバ

イスが CySmart アプリのホーム画面に表示されます。デバイスを選択して、BLE 接続を確立します。接続

が確立されると、黄色の LED (LED1) が点滅状態から常時オン状態に変わります。 

e. カルーセルビューから「Find Me」プロファイルを選択してください。 (カルーセルを回転するには、左ま

たは右にスワイプしてください) 。 

f. [Find Me Profile]画面でアラートレベルの値を選択してください。デバイスの赤色 LED (LED2) の状態がアラ

ートレベルに基づいて変化することを確認してください。 

図 34. iOS 上の CySmart アプリを使用したテスト 
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図 35. Android 上の CySmart アプリを使用したテスト 

 

5. 図 36 に示すように、PUART シリアルポートを使用して、ターミナルウィンドウに Bluetooth スタックとアプリ

ケーショントレースメッセージを表示してください。 

図 36. WICED PUART シリアルポートのログメッセージ 

 

これで、ModusToolbox IDE を使用した CYW20819 デバイス用のシンプルな BLE アプリケーションの開発に成功し

ました。技術文書、追加の Code examples を含む CYW20819 デバイスの詳細については、技術リソースセクション

を参照してください。 

5 まとめ 

このアプリケーションノートでは、CYW20819 BT MCU デバイスアーキテクチャ、関連する開発ツール、および

ModusToolbox を使用して CYW20819 のシンプルな BLE アプリケーションを作成する手順について説明しました。

CYW20819 は、BT 5.0 に準拠したスタンドアロンのベースバンドプロセッサで、BLE とクラシック BT の両方をサ

ポートする 2.4 GHz トランシーバーを統合しています。このデバイスは、オーディオ (ソース) 、センサー (医療、家

庭、セキュリティ) 、HID、リモートコントロール機能、およびその他の IoT アプリケーションのホストでの使用を

目的としています。  

Select your 

device

Select Find Me 

Profile

Select the Alert 

Level
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サイプレスは、エンドアプリケーションの要件を満たす CYW20819 ベースの Bluetooth アプリケーションを迅速に

開発するのに役立つ豊富な Code examples、アプリケーションノート、およびその他の技術ドキュメントを提供し

ています。CYW20819 デバイスについてさらに学習し、Bluetooth アプリケーションを開発するには、技術リソース

のセクションを参照してください。  

6 技術リソース 

アプリケーション注意事項 

AN225684 – CYW20819 の概要 本書。 

サンプル コード 

ModusToolbox IDE を使用した Code examples の包括的なコレクションについては、サイプレス GitHub ポータルの CYW20819 Code 

examples リポジトリにアクセスしてください 

デバイス資料 

CYW20819 デバイスデータシート 

開発キット 

CYW920819EVB-02 評価キット 

ツールのドキュメント 

ModusToolbox IDE IoT デザイナー向けのサイプレス IDE 

 

 
 

 

 

  

http://www.cypress.com/
http://www.cypress.com/an225684
https://github.com/cypresssemiconductorco/Code-Examples-BT-20819A1-1.0-for-ModusToolbox
https://github.com/cypresssemiconductorco/Code-Examples-BT-20819A1-1.0-for-ModusToolbox
https://www.cypress.com/datasheet/CYW20819
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改訂履歴 

文書名: AN225684 - CYW20819 入門 

文書番号: 002-25684 

版 変更内容 

** 
本版は英語版 002-25684 Rev. **について、CYPRESS DEVELOPER COMMUNITY の参画者によって日本語に翻訳された

ドキュメントです。 
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